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SMS 13.3 Tutorial 

Mesh Editing 

Manual mesh editing in SMS 
 

Objectives  

Learn manual mesh generation and editing techniques that can be performed using SMS. For minor 
edits, and for historical support, this tutorial gives a brief introduction to tools in SMS that are useful for 
editing a mesh.  

NOTE: Manually editing a mesh is strongly discouraged. Automated meshing alternatives are preferred. 

Prerequisite Tutorials 

 Overview 

 Map Module 

 Mesh Generation 

Required Components 

 SMS Core 

Time 

 20–35 minutes 

 

SMS 13.3 
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1 Introduction 

This tutorial teaches manual mesh generation and editing techniques that can be 
performed using SMS.  

Note that manual methods are not recommended. Automated mesh generation is 
preferred both for mesh generation as well as mesh revision to ensure the mesh 
generation can be replicated and preserved.  

For minor edits, and for historical support, this tutorial gives a brief introduction to tools 
in SMS that are useful for editing a mesh. 

1. If necessary, start SMS. 

2. If SMS is already open, close any existing data by selecting File | New. A 
dialog may appear asking to save changes. Click Don’t Save to clear all data. 
The graphics window of SMS should refresh to show an empty space. 

2 Importing Topographic Data 

A mesh can be generated directly from topographic data points. Normally these points 
are not spaced in a way that would result in a useful mesh, so this type of data is more 
commonly used to create a scatter set, or TIN.  

However, for illustration of the mesh editing tools, this tutorial will use a preconditioned 
set of points contained in an XYZ file. This file defines a point on each row of the file 
with an X, Y, and Z coordinate. A file of this type may also contain one or more header 
rows defining the contents of the file, source of the data, or identifying the intent of 
each column. This type of file can be opened by SMS.  

To open an XYZ file: 

1. Select File | Open… to bring up the Open dialog. 

2. Navigate to the SMS_Mesh_Editing\data files directory. 

3. Select the file “poway1.xyz”. 

4. Click Open to bring up the Step 1 of 2 page of the File Import Wizard.  

5. In Step 1 of the File Import Wizard, turn on the Space option, then click Next >. 
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6. Change the SMS data type to “Mesh” and make sure the column headings for 
the three data columns show a mapping of “X”, “Y” and “Z”, respectively, in the 
Type row of the File preview section.  

7. Click Finish to close the File Import Wizard and import the data points. 

The data points from the file are converted to mesh nodes and triangulated to form 
triangle elements or cells. From the File Import Wizard, any columnar data can be 
opened into SMS. See the SMS Online Help for more information on the File Import 
Wizard.  

If the display options are set to the factory defaults, the new mesh should appear as 
shown in Figure 1. 

 

Figure 1      The results of triangulating the "poway1.xyz" data 

3 Start Mesh Backup 

Before manually editing the mesh, it is recommended to turn on the Mesh Backup tool. 
While running, this tool will create of a backup of the mesh so, if necessary, the mesh 
can be restored to a previous state. To start the Mesh Backup tool: 

1. Click the Toolbox  macro to open the Toolbox dialog. 

2. On the Tools tab, expand the “  Auto-Backup” folder and select the Mesh 
Backup tool. 

3. Click Run Tool to bring up the Mesh Backup dialog. 

4. For the Maximum number of backups option, enter “100”. 

This sets the tool to create a backup of the mesh every 20 seconds, only if a change 
has been made. It will create up to 100 backup meshes which should be more than 
enough for this tutorial.  

5. Click OK to run the tool and bring up the Turn on/off auto mesh backup dialog. 

Leave the Turn on/off auto mesh backup dialog open. The tool will detect changes to 
the mesh and make a backup mesh.  

The Mesh Reload tool can be used to restore the mesh to a previous state if an error is 
made.  

6. Return to (or reopen) the Toolbox dialog. 
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7. On the Tools tab, under the “  Auto-Backup” folder, select the Mesh Reload 
tool. 

8. Click Run Tool to bring up the Mesh Reload dialog. 

For now, note that the Timestamp option. This option is not populated at this point. This 
option will list points where the Mesh Backup tool saved a change to the mesh. 

9. Click Cancel to exit the Mesh Reload dialog. 

4 Deleting Outer Elements 

The triangulation process always creates elements outside the real mesh boundaries. 
For this tutorial, the mesh should be in the shape of a rotated S, so any elements 
outside of this boundary must be deleted. Do as follows to remove these elements: 

1. Select the Select Element  tool in the toolbox. 

2. Click on an element outside the rotated S shape to select it. 

3. Select another element by holding the Shift key and clicking on it. 

4. Select Edit | Delete or press the Delete key to remove the selected 
elements. 

5. Click Yes at the prompt to confirm the deletion. 

It is tedious to individually select every element that needs to be deleted. SMS provides 
a method to help select groups of adjacent elements by doing the following: 

6. Hold the Ctrl key and click and drag a line through some elements to select 
them. Be careful to only select elements outside the S shape. 

7. Select Edit | Delete or press the Delete key to remove the selected elements. 

8. Click Yes at the prompt to confirm the deletion. 

9. Finish deleting elements that are outside the boundaries of the S shape. 

4.1 Deleting Thin Triangles 

It is not uncommon for the triangulation process to create very thin triangular elements 
outside the desired mesh boundary. The three corner nodes of thin triangles are almost 
collinear, and the elements may be too thin to see or select. If these are not deleted, 
numerical errors in the model solution can result. 

SMS provides a way to define what is meant by “thin triangle” using the element aspect 
ratio. The element “aspect ratio” is the ratio of the element width to its height. Perfect 
equilateral triangles have an aspect ratio of 1.0 while that of thin triangles is much 
less. To define the element aspect ratio, do the following: 

1. Select Elements | Options… to bring up the Element Options dialog. 

2. Set the aspect ratio in the Select thin triangle aspect ratio box to “0.1”.  

Triangular elements with an aspect ratio less than this are considered to be thin 
triangles. 

3. Accept the defaults for the other options and c lick OK to close the Element 
Options dialog. 
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The best aspect ratio to use for selecting thin triangles depends on the mesh. For 
this mesh, the distribution of nodes is rather uniform, so a large aspect ratio will 
suffice. After this value is set, SMS can check for and select thin triangles. To delete any 
remaining thin triangles, follow these steps: 

4. Select Elements | Select Thin Boundary Triangles.  

The lower-right portion of the Status Bar in the Graphics Window shows how many 
elements became selected due to this operation, along with the total area of the 
selected elements. There may be quite a few elements selected. 

5. Select Edit | Delete or press the Delete key. 

6. Click Yes to confirm the deletions.  

The mesh should now look similar to Figure 2. 

 

Figure 2      The poway1 mesh after deleting excess triangles 

5 Merging Triangles 

The mesh is composed entirely of triangles. Both ADCIRC and CGWAVE support only 
triangles. If using one of these models, skip this section of this tutorial . 

Using quadrilateral elements can reduce the number of elements required for a 
simulation and speed up analysis when using RMA2 or similar models because of the 
following: 

 A quadrilateral element covers more area than a triangular element. 

 A quadrilateral can maintain good interior angles (90 degrees) and still have 
high resolution in one direction. This makes these elements more numerically 
stable. 

SMS can automatically merge a pair of triangles into a quadrilateral. Before merging 
triangles, the Merge triangles feature angle should be set. To do this, follow these steps: 

1. Select Elements | Options… to bring up the Element Options dialog again. 

2. Enter a value of “55.0” in the Merge triangles feature angle field. (The default 
value is 65.0.)  

Two triangles may be merged if all angles of the resulting quadrilateral are greater than 
the value specified. 

3. Leave the other options and click OK to close the Element Options dialog. 

Numeric solvers are more stable and accurate when quadrilateral elements are 
rectangular and triangular elements are equilateral. Although it is not practical for a 
mesh to exist entirely of these perfect shapes, the elements should approach these 



SMS Tutorials  Mesh Editing 

 

 Page 6 of 12 © Aquaveo 2023 

shapes as closely as possible. For this reason, SMS merges triangles in an iterative 
manner.  

First, SMS merges elements using the angle criterion of 90°. Then, the angle criterion 
is decreased by a number of steps to the feature angle specified. Slowly decreasing the 
feature angle and testing all triangles against this specified angle will form the best 
shaped elements. 

SMS can merge the triangles in either a selected portion of elements or all elements. In 
order to merge triangles in the entire mesh, no elements should be selected. Do the 
following to merge triangular elements into quadrilateral elements: 

1. Select Elements | Merge Triangles. 

2. Since no elements are selected, a prompt will ask if wanting to merge all 
triangles. Click the Yes button at this prompt. 

With most meshes, as is the case for this example, not all triangles will be merged. The 
mesh will appear as in Figure 3 after SMS merges the triangles. 

 

Figure 3      The poway1 mesh after merging triangles 

6 Editing Individual Elements 

After triangulating the nodes, deleting elements outside the boundaries, and merging 
triangles, the mesh could benefit from manipulation to increase stability. As noted 
above, automated methods for mesh generation are recommended and manual 
manipulation should be kept to a minimum. 

For a main river channel, such as in this model, lines of elements should run parallel to 
the mesh boundary. This is especially important in cases where a port ion of the mesh 
may become dry, so that the mesh will dry parallel to the boundary.  

SMS supports two tools used to manipulate individual elements. 

6.1 Using the Split/Merge Tool 

Most triangular elements in this mesh were merged into quadrilateral elements when the 
Merge Triangles command was performed in Section 4. Some of the elements that 
were not automatically merged can be merged manually. To do this, follow these steps: 

1. Zoom  into the portion of the mesh shown in Figure 4a. Notice the two 
triangular elements that are separated by a number of quadrilateral elements. 

2. Using the Split/Merge  tool, split the quadrilateral, highlighted in Figure 4a, 
by clicking inside it.  

There should now be three triangles, as shown in Figure 4b. 
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3. Merge the top two triangles, highlighted in Figure 4c, by clicking on the edge 

between them. (The Split/Merge  tool should still be selected.) 

The result of this split/merge operation is shown in Figure 4d. There is now one fewer 
quadrilateral between the two triangles. 

 

 

 

 

 

 

(a) Initial elements (b) After splitting quadrilateral 

 

 

 

 

 

 

(c) Merge elements (d) Final elements 

 

To finish editing this section: 

4. Repeat the above split/merge process until there are no more triangles across 
the section. This part of the mesh should look like Figure 5. 

 

Figure 5      The mesh section after merging triangles 

6.2 Using the Swap Edge Tool 

The common edge between two triangles can be swapped. The best way to understand 
this is to think of the two triangles as a quadrilateral, and the common edge between 
them is a diagonal of the quadrilateral. By swapping this common edge, it changes to 
be along the opposite diagonal of the quadrilateral. If this edge is clicked again, it 
returns back to its original state. This can be seen in Figure 6. 

 

Figure 6      The swap edge technique 

        Figure 4      Figure 4     Example of manual split / merge procedure 
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One place in this mesh requires the use of the Swap Edge  tool as well as the 

Split/Merge  tool to be able to merge the triangles. This is located toward the 
middle of the mesh, at the constriction. The easiest way to find this location is to set the 
window boundaries to the correct location by following these steps: 

1. Select Display | View | View Options… which will bring up the Display Options 
dialog. 

2. In the View tab, select the Specify width with height dependent on aspect ratio 
option (this will disable the Bottom (min. Y) field). 

3. Enter these values:  

 Top (max. Y) = “9567” (ft) 

 Left (min. X) = “25164” (ft) 

 Right (max. X) = “25577” (ft) 

4. When done, click OK to close the Display Options dialog. 

The portion of the mesh shown in Figure 7 is now visible. In this part of the mesh, there 
are two triangles that need to be merged together, separated by a single quadrilateral. 
To do this: 

1. Using the Split/Merge  tool, click inside the quadrilateral, highlighted in 
Figure 7a, that separates the two triangles.  

The quadrilateral gets split as shown in Figure 7b. However, the new edge was not 
created in the direction necessary to merge the outer triangles. 

2. Using the Swap Edges  tool, click only once, directly on the edge that was 
just created inside the quadrilateral.  

The edge will swap to the other diagonal of the quadrilateral as shown in Figure 7c. 

3. Using the Split/Merge  tool, merge the top two triangles to form one 
quadrilateral by clicking on the line between the triangles. 

4. Merge the bottom two triangles to form another quadrilateral by clicking on the 
line between the triangles. The result is shown in Figure 7d. 

 

 

 

 

 

 

 (a) The original elements   (b) Elements after splitting quad 

 

 

 

 

 

 

(c) Elements after swapping edge   (d) Final quadrilateral elements 

 Figure 7      Example of manual swapping procedure 
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Although this operation appears simple, it is one that takes some time to get used to 
performing. Many people do not get through this without making a mistake,  w h i c h  
i s  w h y  t h e  M e s h  B a c k u p  t o o l  c a n  b e  u s e f u l However, after understanding 

this operation it becomes easier to use. The Split/Merge  and Swap Edges  tools 
are useful for manually adjusting small areas of the mesh. 

Since the Split/Merge  and Swap Edges  tools are often used together, use the 
opposite tool of the one that is selected by holding down the Shift key. 

5. Continue to merge triangles throughout the domain.  

6. Frame  the mesh. 

Not all of the triangles can be merged. When finished, there should be only six 
triangles left in the finite element mesh. If there is only one triangle in a column of 
quadrilateral elements, that can be a good indicator that this triangle cannot be merged. 
The final mesh should look like Figure 8. 

 

Figure 8      The finite element mesh after merging triangles 

6.3 Renumbering the Mesh 

Any process that edits a mesh, such as those performed in the previous few sections, 
causes the node and element ordering to become disorganized. This random mesh 
ordering decreases the order and efficiency of the matrices required by the analysis 
codes. Renumbering the mesh restores a good mesh ordering, making it more efficient 
to run the analysis.  

To renumber this mesh, follow these steps: 

1. Choose Nodes | Renumber to bring up an Info dialog. 

The Info dialog reports the bandwidth before renumbering and the bandwidth after 
renumbering. Lower bandwidths make the solution process more efficient, and should 
always be done before running a model.  

2. Click OK to close the Info dialog and start the renumbering process. 

When SMS is finished renumbering the mesh, the display will refresh. Remember that 
adding and deleting nodes or elements changes the mesh order. It is important that 
renumbering be the last step of the mesh editing process. Editing a mesh invalidates 
any solution files that have previously been saved. (Solution files are discussed in later 
tutorials.) 

6.4 Checking the Mesh Quality 

Another important item to check with a newly created mesh is the element quality. SMS 
looks at various things when checking this. Do as follows to turn on the mesh quality: 
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1. Select Display | Display Options… to bring up the Display Options dialog 
again. 

2. Select the 2D Mesh tab if it is not already selected. 

3. Turn off the Contours option, then turn on the Mesh quality option. 

4. Click OK to close the Display Options dialog. 

The display will refresh without contours and with the mesh quality, as shown in Figure 
9. Mesh quality shows where problem areas may occur. A legend shows the color 
corresponding with each quality item. See the SMS Online Help for more information on 
these mesh quality options.  

 

Figure 9      Mesh quality for the “poway1” mesh 

 

Many elements are highlighted because of the maximum slope warning. Elements that 
are steep in the flow direction may cause supercritical flow to occur. They also could be 
related to an area where the depth-averaged-flow assumptions are invalid.  

In this mesh, however, the elements are steep in the direction perpendicular to the flow. 
This is a potential area of numerical instability if drying will take place. If a node dries 
on an element that spans a large range of elevation, all the flow through that element 
must be redistributed to other elements. In this case, the entire mesh will be wet, so 
this warning can be ignored.  

To turn off this mesh quality check, do as follows: 

1. Select Display | Display Options… to bring up the Display Options dialog.  

2. Select the 2D Mesh tab if not already selected. 

3. Click the Options… button next to the Mesh quality item. This will bring up the 
Element Quality Checks dialog. 

4. Turn off the Maximum slope option and click OK to close the Element Quality 
Checks dialog. 

5. Click OK to exit the Display Options dialog. 

Once again, the display will refresh (see Figure 10), but this time no slope warnings will 
be shown. There are only ambiguous gradient warnings left for four elements, which 
are shown in Figure 10. 

If the ambiguous gradient is very small, it can be ignored because the surface is  almost 
planar. This is the case with the two ambiguous gradients on the left and the rightmost 
case. Ambiguous gradient cases with a larger variation in elevation, such as the one in 
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the middle of this case, should just be split into two triangular elements using the 

Split/Merge  tool. 

 

Figure 10      Mesh quality without the maximum slope quality check 

The ambiguous gradients can be examined by selecting the nodes on the corners of 

the elements using the Select Mesh Node  tool and viewing the elevation of these 
nodes in the Edit Window above the Graphics Window. 

After making these modifications, it is not necessary to worry about the element quality 
warnings. The following tasks should be done: 

Turn off the display of mesh quality checks to make the screen less cluttered. 

1. Select the Display | Display Options… command to bring up the Display 
Options dialog. 

2. Go to the 2D Mesh tab and turn off the Mesh quality option.  

3. Click OK to close the Display Options dialog. 

7 Reloading a Previous Mesh 

With the Mesh Backup tool running in the background, different versions of the mesh 
during the editing process can be loaded back into SMS by using the Mesh Reload tool. 
This can be used to fix a mistake made during the editing process or to compare the 
mesh changes. The reloaded mesh with be added to the project as a separate mesh, 
preserving the changed mesh. To see how this works, complete the following:  

1. Return to the Turn on/off auto mesh backup dialog. 

2. Click Cancel to close the Turn on/off auto mesh backup dialog. 

3. Return to (or reopen) the Toolbox dialog. 

4. On the Tools tab, under the “  Auto-Backup” folder, select the Mesh Reload 
tool. 

5. Click Run Tool to bring up the Mesh Reload dialog. 

6. Using the Timestamp dropdown option, select one of the earlier time stamps. 

7. For the Reloaded mesh name, enter “reloaded mesh”. 

8. Click OK to close the Mesh Reload dialog and run the tool. 

9. When the tool finishes, click OK to close the Reload from auto mesh backup 
dialog. 
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A new mesh will appear in the Project Explorer that shows the mesh in an earlier state. 
If a mistake was made during the editing process, corrections can be made using the 
reloaded mesh. Comparisons between the earlier mesh and the edited mesh can also 
be made. 

8 Saving the Mesh 

If SMS is registered, then the mesh can be saved. This mesh will not be used in other 
tutorials, so saving it is not required.  

If desired, do the following to save the mesh: 

1. Select File | Save As… to bring up the Save As dialog. 

2. Make sure the Save as type is set to “Project Files (*.sms)”. 

3. Enter the File name “poway1” and click Save to create the project file and close 
the Save As dialog. 

9 Conclusion 

This concludes the “SMS Mesh Editing” tutorial. Although not every option was 
discussed, it is recommended to become familiar with many of the tools that SMS 
provides for mesh editing. Feel free to continue experimenting with the SMS interface. 


